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The Login Screen:
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Enter the Data Source, UserID and Password for your database connection account. Also select the data source type option: Microsoft SQL Server/Sybase or Microsoft Access.

If the data source is a Microsoft Access database, type the full path and filename of the database (e.g. c:\database\mydatabase.mdb). Leave the UserID and Password fields blank, and choose Microsoft Access for the connection method.

jSQL will save the Data Source, UserID and Password (optionally – if specified in the Options screen). When you select a Data Source from the drop-down list, jSQL will restore the UserID and Password that was last used for this Data Source.

To erase items from the Data Source dropdown, right-click anywhere in the gray area of the Login form and choose Delete This Data Source from the pop-up menu.

The Main jSQL Screen:
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Menu

Toolbar


Tab Bar


Query Windows


Results Grid


Query/SQL Box

Sizer Bar

Query Box Splitter

Status Bar

Query Info

SQL queries are typed in the Query/SQL Box and executed with the Execute button (the green arrow). You can also use the hotkeys Ctrl+E or F5, or you can choose SQL, Execute from the menu.

You can customize the look of the query box and results grid through the Options menu. You can also right-click on the query box for additional, advanced settings. For font settings, choose Options, Grid Font or Query Box Font from the menu.

The File Menu:
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1. New
Create a new query window.

2. Open
Open a saved SQL query.

3. Close
Close the active query window.

4. Close All
Close all open query windows.

5. Save
Save the active query window.

6. Save As…
Save the active query window under a new name.

7. Export
Export the results grid to a tab-delimited file.

8. Print
Print the results grid or query box contents.

9. Exit
Close the application.

The Edit Menu:
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1. Cut
Cut the current text selection and save it in the clipboard.

2. Copy
Copy the current text selection to the clipboard.

3. Paste
Paste the text from the clipboard into the current cursor position.

4. Delete
Delete the current text selection.

5. Select All
Select all text in the current query box, or select all cells in the grid (depending on what is active).

6. Time/Date
Enter the current time and date at the current cursor position.

7. Find
Find a specified string in the results grid or query box.

8. Find Next
Find the next occurrence of a specified string.

9. Replace
Search and Replace one string with another.

10. Undo
Undo the last action.

11. Redo
Redo the last action that was un-done by the Undo command.

12. Comment
Comment-out a specified selection in the query window.

13. Uncomment
Uncomment-out a specified selection in the query window.

14. Column Mode
Provides information about Column Mode in the query box. Column mode is always enabled. Hold down the “Alt” key and drag with the mouse to select a block of text.

The SQL Menu:
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1. Execute
Execute the SQL in the query box.

2. Execute Through Position
Execute the SQL in the query box through the current cursor position.

3. Break
Terminate the currently executing SQL query.

4. Clear
Clear the entire contents of the query window.

5. Connect
Connect to a database.

The Options Menu:
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1. Toolbar
Show or Hide the Toolbar.

2. Settings
Show the Options/Settings dialog box.

3. Grid Font
Change the results grid font.

4. Query Box Font
Change the query box font.

5. Query Box Settings
Change advanced query box settings.
The History Menu:
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The History is a saved area that stores your recent queries and results.

1. First
Go to the first item in the History.

2. Previous
Go to the previous item in the History.

3. Next
Go to the next item in the History.

4. Last
Go to the last item in the History.

The Debug Menu:
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1. Prepare Proc for Step Debugging
Automatically prepare a stored procedure for step debugging. This will comment out headers, footers and certain types of commands that will not execute outside of a stored procedure. It will also create a section at the beginning for setting parameters. You can then start step debug mode (F8) and step through your procedure.

2. Prepare Proc for Manual Debugging
Automatically prepare a stored procedure for step debugging. This will comment out headers, footers and certain types of commands that will not execute outside of a stored procedure. It will also create a section at the beginning for setting parameters. You can then execute all or part of your procedure while making adjustments and adding debugging code. Cursors are not currently supported and will be ignored.

3. Remove Debugging Comments
Removes debugging comments added with either prior function. This will restore the procedure to a compliable state, but will still include any changes you made while debugging.

4. Step Into
Begin step debug mode and go to the first executable step in your procedure. If step debug mode is in progress, this will execute the command at the current step. If the current step is an “execute (procedure)” statement, it will open the procedure and step to the first executable line.

5. Step Over
Begin step debug mode and go to the first executable step in your procedure. If step debug mode is in progress, this will execute the command at the current step. This function will not step-into “execute (procedure)” statements, but will simply execute them.

6. Run To Cursor
Begin step debug mode (if not already in this mode) and run to the current cursor position.

7. Run To Breakpoint
Begin step debug mode (if not already in this mode) and run to the next breakpoint.

8. Execute Selected Block
In step debug mode, execute the highlighted block. This is useful for executing long While loops when you do not wish to single-step through every iteration.

9. Restart
Restart step debug mode and clear all variables and temp tables.

10. Stop Debugging
Stop step debug mode.

11. Toggle Breakpoint
Set or unset a breakpoint at the current position.

12. Clear All Breakpoints
Clears all breakpoints and removes the left breakpoint margin (unless normally turned on in the Options screen).

13. Set Next Statement
Sets the current line as the next debug step statement.

14. Show Next Statement
Positions the SQL box position so you can see the current step debug statement.

15. Show Variables
Show the debug variables window. User variable values can also be changed in this window.

The View Menu: 
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1. Refresh (Execute)
Execute the SQL in the query box (same as SQL, Execute).

2. Databases
Show the Databases window, which shows all databases on the server and allows you to select one as your current database.

3. Tables
Show the Tables window, which shows all tables in the current database and allows you to generate scripts for them.

4. Stored Procedures
Show the Stored Procedures window, which shows all Stored Procedures in the current database and allows you to generate scripts for them.

5. Views
Show the Views window, which shows all views in the current database and allows you to generate scripts for them.

6. Indexes
Show the Indexes window, which shows all indexes in the current database and allows you to generate scripts for them.

7. Triggers
Show the Triggers window, which shows all triggers in the current database and allows you to generate scripts for them.

8. User Datatypes
Show the User Datatypes window, which shows all user-defined datatypes in the current database.

9. Close All Object Windows
Closes all open database object windows.

10. Users
Shows the Users window, which shows all users in the current database.

11. Groups
Shows the Groups window, which shows all groups in the current database.

12. Merge
Turns on the Merge feature of the grid, which shows a view that merges like items across cells.

13. Active Connections (sp_who)
Automatically runs the sp_who function and shows a filtered view of active connections only.

14. All Connections (sp_who)
Automatically runs the sp_who function and shows the results, which consists of information about all current database connections.

The Window Menu:
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1. Cascade
Arrange the current query windows in a cascading fashion.

2. Tile Horizontal
Tiles the current query windows horizontally.

3. Tile Vertical
Tiles the current query windows vertically.

4. Arrange Icons
Arranges icons of minimized query windows.

5. Window List
A list of open query windows.

The Toolbar:
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New
Create a new query window.
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Open
Open a saved SQL Query.
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Close
Close the active query window.
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Save
Save the active query window.
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Cut
Cut the current text selection and save it in the clipboard.

[image: image17.png]



Copy
Copy the current text selection to the clipboard.
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Paste
Paste the text from the clipboard into the current cursor position.
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Print
Print the results grid or query box contents.
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Find
Find a specified string in the results grid or query box.
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Options
Show the Options/Settings dialog box.
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Connect
Connect to a database.
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Execute
Execute the SQL in the query box.
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Pause
Pause Step-Debug when auto-stepping. (Only available when step-debugging.)
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Stop/Break
Terminate the currently executing SQL query.
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Databases 
Show the Databases window, which shows all databases on the server and allows you to select one as your current database.
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Tables
Show the Tables window, which shows all tables in the current database and allows you to generate scripts for them.
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Procedures
Show the Stored Procedures window, which shows all Stored Procedures in the current database and allows you to generate scripts for them.
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Views
Show the Views window, which shows all views in the current database and allows you to generate scripts for them.
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Indexes
Show the Indexes window, which shows all indexes in the current database and allows you to generate scripts for them.
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Triggers
Show the Triggers window, which shows all triggers in the current database and allows you to generate scripts for them.
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Tile Horizontally
Tiles the current query windows horizontally.
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Tile Vertically
Tiles the current query windows vertically.
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Cascade Windows
Arrange the current query windows in a cascading fashion.
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Merge Grid Cells
Turns on the Merge feature of the grid, which shows a view that merges like items across cells.
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Comment
Comment-out a specified selection in the query window.
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Uncomment
Uncomment-out a specified selection in the query window. 
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Showplan
Display Showplan information with query results. 
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Statistics
Display Statistics/IO information with query results. 
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Messages Window
Display the database Messages window. 
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iSQL Text Output
Toggle between the output grid and the iSQL text-output view. 
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Timer
Automatically refresh SQL results at an interval specified in the Options screen. A useful example would be to refresh sp_who results to monitor database activity.

Example: Step Debugging

1. Open the stored Procedure.
Click the [image: image43.png]


 toolbar button and double-click a stored procedure to open it:
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2. After opening the procedure, press Ctrl+D to prepare it for debugging. If the procedure has parameters, they will be declared as variables. The first, non-defaulted one to set will be highlighted:
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Example: Step Debugging (continued)

3. Populate all the parameter variables:
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4. Press F8 to start step-debug mode. 

5. HINTS:
a) Press F8 to step through the procedure, executing one statement at a time. This will step into called procedures (exec procname). 
b) Press Shift+F8 to step over calls to called procedures (exec procname).
c) Breakpoints can be set with F9.
d) Set the next statement with Ctrl+F9.
e) View or Edit variables in the Debug Vars window with Shift+F9.
f) Move the mousepointer over a user or system variable to see it’s current value. This will be shown in a tooltip and also in the status bar.

Example: Manual Debugging

1. Open the stored Procedure.
Click the [image: image47.png]


 toolbar button and double-click a stored procedure to open it:
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2. After opening the procedure, press Ctrl+J to prepare it for debugging. If the procedure has parameters, they will be declared as variables. The first, non-defaulted one to set will be highlighted:
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Example: Manual Debugging (continued) 

3. Populate all the parameter variables:
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4. NOTES: 
a) If there are empty begin/end sections, comment them out or add a test select statement (like select ‘TEST’).
b) Cursors are not currently supported, so these must be commented-out or converted to temp-table loops. 
c) Question marks (usually found in comments) are not supported in scripts by the ODBC layer. You will get “Invalid value specified for parameter x” errors. Remove them or you must use the iSQL output view.
 

5. Execute the desired sections of the script:
a) Press Ctrl+E with nothing highlighted to execute the entire script.
b) Highlight the block desired and press Ctrl+E to execute only the selected block. (Note: Execute Selected Text must be enabled on the Options/Query screen.)
c) Move the cursor to the end of the desired block and press Shift+Ctrl+E to execute through the cursor position.


6. To return the code to it’s original state (with any changes included), press Ctrl+L.

The iSQL Text View Mode:

The iSQL Text View mode (Toolbar button [image: image51.png]


) allows you to query a database via iSQL. This is sometimes more reliable for problematic SQL because iSQL uses the native database access layer. However, results are displayed in a plain-text format instead of a spreadsheet-style grid. 

It is recommended that this mode be used in conjunction when Showplan ([image: image52.png]


) or Statistics ([image: image53.png]


) information is desired. If the iSQL Text View mode is turned on, query results are saved in the jSQL history. If the standard grid view is used, Showplan or Statistics information will be written to the pop-up Messages window, and prior results are overwritten with each execution.

The iSQL Text View mode shown with Statistics turned on:
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The Options/Settings Dialog Box: General Tab
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1. Drop Table statements in Table Extracts. 
With this option enabled, DROP TABLE statements will be included when you extract table scripts.

2. Edit-Copy Headers with Row/Col Selection.
With this option enabled, headers will be included when you copy entire rows or columns to the clipboard.

3. Enable Beep.
With this option enabled, jSQL will play a beep sound after many functions and on errors.

4. Hide Object Windows After Opening Script.
With this option enabled, object windows (like the Tables or Procedures window) will be hidden after extracting a script. Turn this off to keep object windows visible until you manually close them.

5. Keep DB Object Windows on Top.
With this option enabled, object windows will always stay on top.

6. Minimize Object Windows with Main App.
With this option enabled, object windows will be minimized with the main jSQL application.

7. Save Connection Passwords.
With this option enabled, connection passwords will be encrypted and saved in the registry.

8. Save Duplicate History Items.
With this option enabled, duplicate history items will be saved in the jSQL History. Turn this off to eliminate duplicate history items.

9. Sort Grid with Right-Click in Header.
With this option enabled, right-click the in grid header to sort. Turn this off to sort with a single click in the header.

10. Sync Dividers.
With this option enabled, the splitter dividers will stay in-sync across all query windows. Turn this off to set different splits in each window.

11. Toolbar Buttons Are Show/Hide Toggles.
With this option enabled, object window Toolbar buttons (like the Tables or Procedures window) act as Show/Hide toggles. Turn this off to have buttons always show the windows. (Usually preferred off if Keep DB Windows on Top is turned off.) 

12. Connection Method.
The connection layer used for database connections. Only ADO supports the full range of jSQL features, like step debugging.

The Options/Settings Dialog Box: Edit Tab
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1. Allow Positioning Beyond Line End. 
With this option enabled, you can position the cursor at column positions beyond the line end.

2. Auto Indent.
With this option enabled, “smart indenting” is enabled in text boxes.

3. Display Left Margin.
With this option enabled, a left border margin will be display in text boxes. This is used for bookmark arrows. Bookmarks can be toggled with F9. Jump to the next bookmark with F2, or Shift-F2 for the prior bookmark.

4. Horizontal Scrollbar.
With this option enabled, the horizontal scrollbar will be visible in text boxes.

5. Line Numbering.
With this option enabled, line numbers will appear in text boxes.

6. Smooth Scrolling.
With this option enabled, smooth scrolling will be enabled in text boxes.

7. Syntax Coloring.
With this option enabled, SQL syntax coloring will be turned on in SQL text boxes.

8. Use Spaces in Place of Tabs.
With this option enabled, tabs will be replaced with spaces when you press the tab key in text boxes.

9. Tab Width (Characters).
This specifies the tab width in characters in text boxes.

10. Maximum History Items.
This specifies the maximum number of history items (query and result sets) to save in the jSQL History.

The Options/Settings Dialog Box: Query Tab
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1. Alternate Row Grid Shading. 
With this option enabled, the results grid will be formatted with alternating white and gray coloring.

2. Autosize Columns.
With this option enabled, columns in the results grid are auto-sized based on the contents of each column.

3. Execute Selected Text.
With this option enabled, jSQL will execute highlighted sections of your query. (The contents of the entire SQL Query window will still be executed if nothing is selected.) Use the mouse to click and drag to highlight a selection, or hold the Shift key and use the arrows. Turn this off if you always want the entire contents of the SQL query box executed, regardless of the selection.

4. Reconnect to DB before every Query.
With this option enabled, jSQL will automatically reconnect to the database every time you execute a query. This is useful if you are creating temp tables and you want them automatically deleted prior to re-executing your query.

5. Set Focus to Table after Execute.
With this option enabled, focus will be set to the results grid after executing a query. This is useful if you typically like to browse the results grid with the arrow keys after a query, and you don’t want to use the mouse to set focus to the grid each time.

6. Show Empty Results.
With this option enabled, empty resultsets will be shown. Empty resultsets occur from executing non-select statements (like SET or SELECT @var= statements). This option is only applicable in Sybase when Sybase Open Client Batching Fix is disabled (not recommended).

7. Sybase 12.5 Null Bug Fix.
With this option enabled, jSQL will add “--“ (comment) characters after every line that ends in “null.” There is a but associated with Sybase 12.5 that removes the line feed after lines that end in “null,“ which will result in running lines of your script together. JSQL works around this bug by adding the comment characters.

8. Sybase Open Client Batching Fix.
With this option enabled, jSQL will add “SDIB=1” to the ODBC connection string. This fixes a Sybase problem where multiple resultsets are not all returned in many situations.

9. Use iSQL for Showplan/Statistics.
With this option enabled, jSQL will send queries via iSQL when Showplan ([image: image58.png]


) or Statistics ([image: image59.png]


) are turned on. This results in more accurate ShowPlan and Statistics information when accessing a Sybase database. Sybase ODBC driver support for Showplan and Statistics is flawed, and iSQL uses a native Sybase connection method

10. Date Format.
Set the format for returning date/time fields with this setting. The small, second box is for the millisecond delimiter. Millisecond support can be enabled or disabled with the “ms” checkbox.

11. Connection Timeout (Minutes).
Set the database connection timeout with this setting. Set this to zero (0) to disable the timeout.

12. Maximum Return Records.
This is the maximum number of records that can be loaded by jSQL. Use this to constrain memory or result set load time.

13. Null String.
Use this to determine what jSQL should use to represent nulls in the results grid.

14. Timer Interval (Seconds).
Use this to set the timer interval in seconds. The timer ([image: image60.png]


) can  be used to automatically execute a SQL query at an interval length specified here.

Scripting Objects in a Database.

You can script multiple database objects (Tables/Procedures/Views/Indexes/Triggers) in one step. The results can be returned in a single query window or in separate windows.

1. Open the desired object list by clicking its toolbar button. (Stored Procedure list pictured here.)
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2. Highlight the desired objects. Multiple objects can be highlighted by using the shift or ctrl key.
3. Click the “Script” button. Click “Yes” to load the objects in separate windows or “No” to load them all in one window. 

Additional Features of the Results Grid.

· You can sum a range in the results grid by highlighting it with the mouse or cursor keys. The sum is shown in the status bar.

· You can delete rows or columns in the results grid by highlighting a range with the mouse or cursor keys, right-clicking and choosing Delete Selected Rows or Delete Selected Columns.

· To count the rows or columns in a specified range, highlight the range with the mouse or cursor keys. The row and column count will be displayed in the status bar (e.g. [25R x 2C]). 

